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Preface

The SunPCi User’s Guide provides installation and operation instructions for the
SunPCi

TM

software. In addition, this guide explains how to install Windows 95 on
your UltraSPARC

TM

workstation.

In order to fully use the information in this document, you should first have installed
the SunPCi card in your system. The SunPCi software will not run properly without
the card installed.

Refer to the SunPCi Installation Guide for more information.

Who Should Read This Book
This guide is intended for all users of the SunPCi software. Whether you are a
general user working with SunPCi regularly or an administrator responsible for
installing and maintaining numerous SunPCi setups, this guide provides the
information you need to install and use the SunPCi software and Windows 95.

The topics in this guide are explained with the non-technical user in mind. However,
you do need to understand the basics of working with the Solaris

TM

operating
environment, the OpenDOS

TM

operating system, and the desired version of Windows
software. OpenDOS 7.01 is a superset of MS-DOS 6.22.

How This Book Is Organized
This guide is divided into five chapters and five appendixes, as follows:
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Chapter 1,” describes SunPCi and introduces you to its features.

Chapter 2, “Getting Started,” lists the contacts of your SunPCi package and explains
the system requirements that your workstation must meet in order to successfully
install and run SunPCi.

Chapter 3,” describes how to install the SunPCi software. This chapter also contains
instructions for installing Windows 95.

Chapter 4,” describes how to connect peripheral devices (such as printers, serial
devices, and audio devices) to the SunPCi card. Some of these connections require
the optional add-on backplate (included in the SunPCi package).

Chapter 5,” outlines some helpful hints that you may find useful while running
SunPCi.

Appendix A,” provides some possible explanations of problems you may encounter
and suggests some possible solutions.

Appendix B,” describes how to configure SunPCi to work with international
keyboards.

Appendix C,” includes some suggestions on how to improve SunPCi performance.

Document Conventions
This manual uses certain standard document conventions. The following sections
explain those conventions and how to interpret them.

Solaris Command Windows
In this guide, you are often instructed to open a command window when performing
various tasks. Depending on your choice, you can use either a Solaris Command Tool
window or Shell Tool window in OpenWindows. These two types of command
windows are a standard part of the Solaris operating environment. In CDE, these
command windows are called Console and Terminal windows.

Typographic Changes and Symbols
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TABLE P–1 Typographic Conventions

Typeface or
Symbol Meaning Examples

AaBbCc123 The names of commands, files, and
directories; on-screen computer
output.

Edit your .login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when contrasted
with on-screen computer output.

%su

Password: xyz

AaBbCc123 Book titles, new words or terms,
words to be emphasized.

Command-line variable; replace
with a real name or value.

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be root to do this.

To delete a file, type rm filename.

SunPCi Keyboard Accelerators
The SunPCi software provides keyboard accelerators for many of the functions on
the menus at the top of the SunPCi window. To see the available accelerators, hold
down the left mouse button on the menu until the drop-down menu appears. Next
to each command is the equivalent keyboard accelerator.

In CDE and OpenWindows, these accelerators use the Meta key () in combination
with another key. The Meta key is located on either side of the spacebar on your
keyboard. To use any of the keyboard accelerators, hold down the Meta key and
press the second key. For example, the Meta-E key combination means “press both
the Meta key and the E key at the same time.”

Sun Keyboard Meta Key
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Customer Support
If you cannot find the information you need in this guide, call your SunPCi
distributor or your local support center. For assistance outside the United States,
contact your Sun sales representative.

Related Documentation
The complete documentation set for the OpenDOS operating system can be found on
the World Wide Web at http://www.caldera.com . For information on the version
of Windows you are using, consult the related Windows documentation.

The following table describes the related Sun documentation for SunPCi.

TABLE P–2 Related Documentation

Application Title Part Number

Installation, hardware and SunPCi
software

SunPCi Installation Guide 805-6055-10

Installation (X-Option), optional
128 Mbyte RAM DIMM

SunPCi DIMM Installation Guide 805-7205-10

Sun Documentation on the Web
The docs.sun.com web site enables you to access Sun technical documentation on
the World Wide Web. You can browse the docs.sun.com archive or search for a
specific book title or subject at:

http://docs.sun.com
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Sun Welcomes Your Comments
We are interested in improving our documentation and welcome your comments and
suggestions. You can email your comments to us at:

docfeedback@sun.com.

Please include the part number of the document for which you are sending
comments in the subject line of your email.
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CHAPTER 1

What Is SunPCi?

SunPCi software and hardware provide a complete PC hardware environment on
your PCI-based SPARC

TM

workstation or server running the Solaris operating
environment. With SunPCi, you can run Windows 95 applications on your
workstation, alongside your Solaris applications.

SunPCi Features
The following list describes some of the PC features that SunPCi brings to your
Solaris desktop:

An Intel-compatible PC on your Solaris desktop

With the SunPCi card installed in your workstation or server, SunPCi contains an
Intel-compatible PC processor on the board.

High-resolution VGA display for your Microsoft Windows applications

SunPCi includes two Windows super-VGA display drivers. One displays the
Windows desktop in an X window on your screen; the other displays on an external
VGA monitor. You can choose to install either option.

Your familiar PC peripherals

SunPCi provides Microsoft Mouse and IBM PC keyboard emulation, plus access to
external peripherals such as printers and modems. The SunPCi accelerator card and
optional add-on backplate contain the physical connections for PC peripheral devices.

Access to network services, files, and printers
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SunPCi enables you to connect to your Ethernet network. It also allows you to access
Solaris files and printers on the network through the physical connections on the
accelerator card and backplate.

The software package includes the Caldera OpenDOS 7.01 operating system. You
must purchase Windows 95 and your Windows applications separately.

From the PC User’s Perspective
From the perspective of a PC user, SunPCi software includes the following PC
features:

� Emulated hard drives, which function like local PC hard drives

� Extended drives, similar to networked drives on a PC

� IBM PC and PC keyboard emulation

� Access to serial, parallel, and USB peripherals, such as printers

� 64 Mbytes of on-board memory (standard), plus a second slot for additional
memory (64 and 128 Mbyte options are available; you can install two 128 MByte
modules for a maximum 256 MBytes)

� Access to PC-based networks, including file and print servers

� Ability to use an optional VGA monitor

From the Workstation User’s Perspective
From the perspective of a SPARC Solaris workstation user, SunPCi software provides
advantages, such as:

� Reliable access to thousands of PC applications, including custom internal
applications that your company relies on daily

� Ability to display super-VGA graphics with 24-bit color

� Ability to share network resources between the PC and Solaris environments, such
as printers and files

� Ability to copy and paste text between OpenDOS or Windows and
OpenWindows/CDE applications

� Access to PC-based networks, including Novell NetWare file and print servers
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How to Proceed
To install the SunPCi software, proceed to Chapter 3. Once you have installed and
configured the SunPCi software, you can install Windows 95 and the SunPCi drivers.

Chapter 4 contains information on how to install and configure peripheral devices
with SunPCi.

Getting Help for SunPCi
You can turn to the following additional sources for help with SunPCi software:

� SunPCi Help menu

� Solaris online manual pages

� DOS-related manual pages

� Customer Support

The following sections explain these sources.

SunPCi Help Menu
Help for SunPCi is available through the Help menu at the top of the SunPCi
window.

Note - The F1 key does not provide help for SunPCi windows.

Solaris Online Manual Pages
You may occasionally have questions regarding the Solaris operating system itself.
For such information, try using the Solaris online manual pages (also called man
pages).

To use Solaris online manual pages, perform the following procedure:

1. Type the word man, followed by the name of the command in which you are
interested, and then press Return.

For example, to get help on the sunpci command, type the following command
and then press Return:

What Is SunPCi? 3



% man sunpci

The system responds Reformatting page... wait , and then displays a section
of the manual page in the command window. To scroll through the manual page,
press any key. To exit the manual page, press Control-C.

For information on how to add the SunPCi man page directory to your MANPATH
environment variable, refer to your Solaris documentation.

Getting Help for Windows 95
To get help for Windows 95 while you are working in the SunPCi window and
Windows is running, press F1 or select Help from the Help menu in any window.
This brings up the Contents window for Windows 95 help.

Note - Windows 95 help does not contain help for the SunPCi application.
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CHAPTER 2

Getting Started

This chapter lists the contents of your SunPCi installation package, describes the
SunPCi system requirements, and provides basic information about SunPCi
installation. The following list describes the topics included in this chapter.

� “SunPCi Installation Package Contents” on page 5 “SunPCi Installation Package
Contents” on page 5

� “System Requirements” on page 5 “System Requirements” on page 5

� “SunPCi Card” on page 6 “SunPCi Card” on page 6

SunPCi Installation Package Contents
Verify that your SunPCi installation package includes the following items:

� SunPCi CD-ROM — This includes the SunPCi software and this manual in
AnswerBook2

TM

format

� The SunPCi Installation Guide — This manual includes information on installing
the SunPCi card, the AnswerBook2 utility, and the SunPCi software

If any of these items is missing, contact your Sun service representative.

System Requirements
To install and use SunPCi software, you need the following:

� PCI-based UltraSPARC computer.
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� Solaris 2.5.1, 2.6, or Solaris 7 operating environment.

� CD-ROM drive; either local (attached to your system), or remote (attached to
another system on your network).

� Hard disk; either local or remote, with at least 40 Mbytes of available storage
space for the SunPCi package. More storage will be required for Windows 95 (at
least 128 MB).

� At least 64 Mbytes of random-access memory (RAM); more is preferred.

SunPCi Card
You must have a SunPCi card installed in your PCI-based system if you want to run
SunPCi. SunPCi does not support “software-only” operation, and it does not run on
SBus-based systems. Refer to the SunPCi Installation Guide for more information.
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CHAPTER 3

Starting SunPCi Software for the First
Time

This chapter discusses the following topics:

� “Starting Up SunPCi” on page 7 “Starting Up SunPCi” on page 7

� “Installing Windows 95 Software” on page 8 “Installing Windows 95 Software”
on page 8

� “Creating and Configuring a New C: or D: Drive” on page 12 “Creating and
Configuring a New C: or D: Drive” on page 12

� “Exiting SunPCi” on page 15 “Exiting SunPCi” on page 15

Note - Make sure that you are logged in as a regular user, not as superuser, before
you perform the procedures in the following sections. If you are logged in as
superuser, type exit to return to the %prompt.

Starting Up SunPCi
To start the SunPCi program, type the following command at the % prompt and
press Return:

% /opt/SUNWspci/bin/sunpci

The SunPCi program starts, and a SunPCi window is displayed. When you start
SunPCi software for the first time after installation, the program takes a few minutes
to create a directory named ~/pc , in which several SunPCi files are also created.
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When you subsequently restart SunPCi software, the SunPCi window will come up
more quickly, because these files and directories do not need to be created again.

When the SunPCi software has finished starting up, the screen displays the DOS
prompt (C:\> ). You can use OpenDOS with your DOS applications, or you can
install Windows 95. The following sections describe how to install Windows 95 and
the SunPCi drivers.

Note - If you do not want to type the full path of SunPCi every time you want to
run the software, you can modify the $path statement in your .login or .cshrc
file. For information on how to do this, refer to your Solaris documentation.

Installing Windows 95 Software
In order to install Windows 95 on SunPCi, you will need one of the following:

� Windows 95 full installation CD, or

� Windows 3.x diskettes and a Windows 95 upgrade CD

This section explains how to install Windows 95 and how to install the SunPCi
drivers. Before you start the installation, make sure your home directory contains
sufficient disk space. Windows 95 requires a minimum of 128 Mbytes of free hard
disk space.

To install Windows 95 on SunPCi, follow this procedure:

1. If the SunPCi CD is still in your CD-ROM drive, type eject in a terminal
window and then remove the CD. Insert your Windows 95 CD into the
CD-ROM drive.

The CD should mount automatically and display its contents in a window on the
screen. If it does not, then Solaris Volume Manager may not be enabled on your
system.

2. To find out if Volume Manager is enabled, open a terminal window on your
workstation desktop and type ps -df | grep vold .

The system returns information on the Volume Manager process (vold ) if it is
enabled. If it is enabled, skip steps 3 and 4 and proceed to step 5.

If your workstation does not have Solaris Volume Manager enabled, you will
need to become superuser and mount the CD-ROM drive manually as described
in the next step.
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Note - If you want to use your workstation’s floppy drive as drive A:, you will
need to run the vold_floppy_disable script. Refer to “Diskette Drives” on
page 33 for more information.

3. If Solaris Volume Manager is not enabled, become superuser and then type
cd / to change to the root partition. If your workstation has Solaris Volume
Manager enabled, skip this step.

If your CD-ROM drive is a SCSI drive, type the following command in a terminal
window on your workstation to mount the CD-ROM drive:

# mount -o ro -F hsfs /dev/dsk/c0t6d0s2 /cdrom

Note - Make sure you type -o with no space between the minus sign and the
letter o.

If your workstation (Ultra 5 or Ultra 10) has an IDE drive, the device will be
/dev/dsk/c0t2d0s2 .

4. Exit superuser status. If you are not logged in as superuser, skip this step.

5. In the SunPCi window, type the following command at the DOS prompt and
press Return:

C:\> r:\cdrom\cdrom0\setup.exe

6. Press Return to start the setup routine.

Follow the instructions on the screen. During the installation process, select the
options that are appropriate to your installation (typical, compact, and so on).

Note - If you needed to mount the CD-ROM drive manually, replace the
\cdrom\cdrom0 path with the path for the location at which the CD-ROM drive
is mounted.

The screen responds with the message
Setup is now going to perform a routine check on your system .
The Scandisk utility executes.

After the Scandisk utility has completed, the screen displays the message
Please wait while Setup initializes . The Welcome to Windows Setup
window is displayed.
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7. You will notice that the SunPCi window shows two mouse cursors. Click on
the SunPCi window, and then select the Options menu at the top of the
window. Choose Attach Mouse from the drop-down menu.

You should now see a single mouse cursor. The top of the SunPCi window reads
(Mouse Attached) . You may notice that the mouse movement is somewhat
jerky. This will be fixed when you install the SunPCi drivers.

8. Click Continue.

The Windows 95 Setup Window is displayed, along with the message
Preparing Windows 95 Setup Wizard .

The Windows installation program loads some files, and then displays the
Windows 95 License Agreement.

9. Click Yes to continue, and then follow the instructions on the screen.

10. When the Setup Wizard dialog box appears, click Next to continue, and then
continue through the Setup Wizard’s installation process. When asked to select
options for your installation, choose the type of installation you want to
perform (typical, compact, and so on).

For the Windows 95 serial number and other Windows-related information, refer to
your Windows 95 documentation.

A series of informational screens is displayed as the installation continues. When the
installation is finished, the setup program will automatically reboot SunPCi. After the
setup process is complete, a Welcome to Windows 95 dialog box is displayed.

Note - When the Analyzing Your Computer screen appears, do not check any of the
devices it has listed (for example, CD-ROM drives). Just click Next and continue
through the installation process. You will install SunPCi-specific drivers for these
devices later on in this procedure.

1. Click Close to close this dialog box.

The Windows 95 installation proceeds. Follow the instructions on the screen.

After you finish installing Windows 95, you will need to install the SunPCi drivers.
Proceed to the following section.
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Installing the SunPCi Drivers
The setup utility installs the SunPCi drivers. You execute this utility from within
Windows 95.

1. Click the Start button and select Run from the pop-up menu.

A dialog box is displayed.

2. Type the following path into the dialog box and click OK:

f:\drivers\win95\setup

The screen responds with the message
Setup is preparing the InstallShield Wizard . The InstallShield
Wizard window is then displayed, along with a progress bar.

The Welcome to the SunPCi Setup Program screen is displayed.

Note - Depending on your installation, you may be asked to provide your user
name and password for Microsoft Networking. Follow the instructions in Step 1
on page 8, and then continue with drivers setup.

3. Click Next to continue.

The SunPCi Drivers Setup screen appears.

4. Choose Workstation Monitor if you plan to run SunPCi from your main
workstation monitor, or External Monitor if you have connected a VGA
monitor to the back of the SunPCi card.

Click Next. The installation proceeds automatically. When the installation has
finished, a dialog box is displayed with the message
The installation of the SunPCi drivers has finished . The dialog
box asks you to exit all applications and reboot Windows 95.

5. Click OK to close the dialog box.

6. Click Start and select Shut Down from the pop-up menu.

A dialog box is displayed; select Restart the Computer and click Yes.

7. Once SunPCi reboots, a dialog box is displayed asking you to enter a network
password for Microsoft Networking.

Type your UNIX workstation user name and password and press Return.
Confirm your password when the program asks you to.

Note that after SunPCi reboots, the top of the SunPCi window no longer reads
(Mouse Attached) and you will see only one mouse cursor. Now that the
drivers are installed, you do not need to attach the mouse.
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Note - You need to log on to Microsoft Networking each time Windows 95 starts
up. If you do not log on, you will not be able to gain access to your extended
(network) drives. Extended drives are the drives you set up using Windows
Explorer.

Creating and Configuring a New C: or
D: Drive
When you first install the SunPCi software and start the application for the first time,
SunPCi automatically creates a new C: drive for you, called C.diskimage . This file
resides in the /pc subdirectory in your home directory.

If you want to create and attach a hard drive file for drive D:, or attach a different
file to drive C:, follow the procedures in this section.

Note - When you installed Windows 95 in the previous procedure, you installed it
on the C: drive file C.diskimage . If you create a new drive and attach that new
drive as drive C:, you will need to install Windows 95 on that drive as well.

Creating a Hard Drive File
To create a new hard drive file, follow these steps:

1. Start SunPCi, if it is not already running.

2. Choose the Options menu at the top of the SunPCi window.

The Options drop-down menu is displayed. Figure 3–1 shows the Options menu.
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Figure 3–1 SunPCi Options Menu

3. Select the Create New Drive command from the drop-down menu.

The Create New Hard Drive dialog box is displayed. Figure 3–2 shows the Create
New Hard Drive dialog box.

Figure 3–2 Create New Hard Drive Dialog Box

4. If you want to attach the disk drive as drive C:, click the button next to Attach
New Hard Drive As C:. If you want to attach the new drive as drive D:, click
the button next to D:. If you want to create the drive file but not attach is, click
the Do Not Attach button.
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5. Drag the slider to the desired drive size in MB (megabytes).

Make sure that your disk size is at least 60 Mbytes; the maximum of 500 Mbytes
is preferred, depending on the available disk space on your workstation.

Note - An emulated drive is actually a large file, and SunPCi allocates disk space
for emulated drives in a dynamic manner rather than in a static one. This means
that although you can allocate a maximum of 500 Mbytes for a hard disk, the
actual size of the disk depends on the amount of data that is stored in it at a
given point in time. As the amount of data increases, the size of the emulated
hard disk increases. Make sure that you have enough hard disk space on your
workstation to accommodate a C: or D: drive of the size you specify.

6. Click in the Selection field at the bottom of the dialog box. Type in the file
name you want to use for the new drive (for example, C.newdisk ).

7. Click on OK to create the disk file.

SunPCi prompts you to shut down Windows and reboot. Click on OK.

8. Click on the Start button, then Shut Down to shut down Windows 95.

9. From the File menu, choose Reset PC to reboot SunPCi.

You are now ready to install other Windows programs on your new disk drives.

Attaching a Drive File to C: or D:
If you have already attached the drive file in the previous step, skip this procedure.

After you have created a drive file, you need to attach it to one of your emulated
hard drives. You can either do this in the Create New Hard Drive dialog box, as
explained in the previous section, or you can attach the drive file in a separate step.
(For example, if you clicked the Do Not Attach button in the Create New Hard Disk
dialog box, you would need to attach the drive file before using it.)

To attach the file, perform the following procedure:

1. From the Options menu, choose the Hard Disk Selection command.

The SunPCi Drive Attach dialog box is displayed.

2. Type in the path and file name of the file you created in “Creating a Hard
Drive File” on page 12.

If you want to make this file a new C: drive, type it into the C: Drive field. If you
want the file to attach to a D: drive, type the path and file name into the D: Drive
field.

14 SunPCi User’s Guide ♦ Revision A, January 1999



3. Click OK.

The file is now attached to C: or D:.

4. From the File menu, choose Reboot to apply your changes.

SunPCi displays the Reboot dialog box.

5. Click OK.

SunPCi reboots and uses the new attached drives.

How to Proceed
� Refer to Chapter 4 if you want to connect peripheral devices (such as audio

devices and printers) to SunPCi.

� Refer to Chapter 5 if you want to learn the basics of SunPCi operation. This
chapter explains how to start and exit the software, as well as how to use
command line options, the SunPCi windows, and other features of the SunPCi
software.

� Refer to Appendix A if you encountered any difficulties while installing or
running SunPCi software orWindows 95.

� If you want to exit SunPCi, proceed to the following section.

Exiting SunPCi
To exit SunPCi, you need to perform two steps:

� Exit Windows 95

� Exit the SunPCi window

Note - Always shut down Windows 95 from the Start menu before exiting the
SunPCi window. Otherwise, your files and applications could become corrupted.

The following steps explain how to shut down SunPCi properly.

1. In Windows 95, click on Start, and then choose Shut down the computer.

Windows 95 closes and displays a message that it is now safe to turn off your
computer.
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2. From the File menu in the SunPCi window, choose Exit.
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CHAPTER 4

Configuring Peripheral Devices

You can attach a number of peripheral devices to the SunPCi card and optional
add-on backplate and operate them as if they were connected to a PC. This chapter
contains instructions for installing and configuring the following peripherals:

� Audio, video, and USB connections

� Connecting a local printer or other parallel device

� Connecting a serial device

� Networking with SunPCi

� Using a different SPARC keyboard, or any additional information concerning
foreign language keyboards

Audio, Video, and USB Connections
The backplate of the SunPCi card contains three audio ports (Line In, Line Out, and
Microphone), an external video port, and a USB (Universal System Bus) port. The
USB port can accommodate any USB device, such as a digital camera or a printer.

Note - The SunPCi audio ports do not route audio through your workstation’s
speakers. In order to hear the audio, you will need to connect a separate set of
speakers or headphones to the Line Out port.

If you are connecting external devices to the USB connector, you will need to provide
an external powered hub for your USB devices. If you do not use an external hub,
your USB devices may fail to power up.

Figure 4–1 shows the ports on the SunPCi card’s add-on backplate.
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Figure 4–1 SunPCi Cable Connections

Connecting an External Monitor to SunPCi
You can connect an external VGA monitor to the video output on the SunPCi card.
This enables you to run PC applications on a different monitor, thus saving space on
your workstation monitor. You may also want to use an external monitor for
applications using direct VGA control, DirectX, animation, or high-performance
video.

To connect the external monitor to SunPCi, attach the monitor cable to the video port
on the SunPCi card.
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Note - For more information on how to fine-tune external VGA performance for use
with PC-based game software, refer to “Fine-Tuning Your SunPCi Configuration” on
page 65.

Selecting and Installing the Video Drivers
After you connect the VGA monitor to SunPCi, you need to install the correct video
drivers for your configuration. When you installed the SunPCi software as described
in Chapter 3, you installed the SunPCi drivers by default using the setup utility. If
you always plan to use SunPCi on your workstation’s desktop, you do not need to
install another driver.

In order to configure the video correctly, you need to install the proper drivers for
your hardware setup and operating system. There are two types of drivers available:
the SunPCi drivers for the on-board (workstation) video, and SMI for the external
VGA video. After you install the drivers, you choose the video you want to use with
the VGA command switch.

To install the external video driver after you have installed the SunPCi drivers, run
the setup utility again. When the utility asks you which monitor you would like to
use to display your video, choose External Monitor. For instructions on how to run
the utility, refer to “Installing the SunPCi Drivers” on page 11.

For the workstation video, SMI mode refers to the way that SunPCi runs DOS,
Windows installation programs, Windows Safe Mode, and full-screen DOS in
Windows. This is the video display you see before you install the SunPCi drivers.
SMI also controls VGA mode for the external video.

Using the Driver Switches With SunPCi
To use external VGA with SunPCi, type the following command at the system
prompt:

% sunpci -vga

To use SunPCi with the on-board (workstation) video, just type the standard sunpci
command at the system prompt. Table 4–1 describes the type of video output that
occurs for the operating system you want to use, the video driver you have installed,
and whether or not you typed sunpci -vga at the prompt.
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TABLE 4–1 Video Options Matrix

PC Operating System VGA Monitor Connected
VGA Monitor Not
Connected

DOS (-vga switch used) Video is routed to VGA
monitor

Video discarded; SunPCi
window displays “Video
routed” message

DOS (-vga switch not used) Video is routed to SunPCi
window on workstation
screen

Video is routed to SunPCi
window on workstation
screen

Windows 95 VGA driver
used

Video is routed to VGA
monitor

Video discarded

Windows 95 SunPCi drivers
installed

Video is routed to SunPCi
window on workstation
screen

Video is routed to SunPCi
window on workstation
screen

Note - If you have the VGA driver installed but do not have an external VGA
monitor attached, and you want to install the SunPCi drivers, you can follow the
instructions in Chapter 3 for installing the SunPCi drivers.

Connecting a Local Printer or Parallel
Device
The optional add-on backplate (included with the SunPCi card) features a parallel
port that you can use to connect a printer (or other parallel device) to SunPCi. Figure
4–2 shows the connectors on the add-on backplate.
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Figure 4–2 Add-On Backplate Connections

If you have not already installed the add-on backplate, you will need to do so before
attaching the printer. Refer to the SunPCi Installation Guide for instructions on how
to install the backplate.

Once you have installed the add-on backplate, you can attach the parallel cable to the
backplate’s parallel port. SunPCi’s parallel port is assigned to LPT1. You can assign
the printer to the printer port by using the corresponding Control Panel in Windows
95. For more information on setting up printing in Windows 95, refer to Chapter 5.

To print to the parallel port with SunPCi, simply use the Print command from your
PC-based application, just as you would from a PC.

Note - These instructions apply to a local printer that you would attach to your
SunPCi card. For information on how to use your Solaris printer with Windows 95,
refer to “Printing from Windows 95 Using Solaris Printers” on page 36.

Connecting a Serial Device
The optional add-on backplate contains a serial port that you can use to connect a
modem or serial device to SunPCi. This serial port is assigned to COM1. Figure 4–2
shows the location of the serial port on the backplate.
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To use the serial port, connect the serial cable from your device to the COM port on
the add-on backplate. If you need to install any additional drivers for the device you
want to use, have the software diskette or CD handy and use the corresponding
Control Panel to install the drivers. For more information on connecting and using
the serial device, refer to the documentation that came with your serial device.

Networking With SunPCi
SunPCi includes a new NDIS driver; this driver allows you to connect your SunPCi
host to an Ethernet network. The new driver supports is designed for use with
Windows 95.

Configuring the Network Protocols in Windows 95
You usually configure the network protocols as part of the Windows 95 installation
procedure. If you changed networks or network properties, or if you did not set up
the network during the installation process, use the procedures in this section to
connect to your network.

To diagnose problems with your network, refer to Appendix A.

Setting TCP/IP Properties
Before you can configure TCP/IP, you will need to obtain certain information from
the network administrator at your site. Make sure you have the following
information before you begin:

� Your SunPCi computer name (the one you entered when you installed Windows
95). This name also appears on the Identification tab of the Network Control
Panel. (The Network Control Panel is explained in the following procedure.)

� The IP address for your SunPCi computer (must be different from your
workstation’s IP address).

� The subnet mask for your site’s network.

� The IP address for your gateway (if used).

� The host name, domain name, and IP address for each DNS (Domain Name
Service) server at your site (if used).

To configure TCP/IP, use the Network Control Panel in Windows 95. Enter the
information you obtained in this list in the corresponding fields. For more
information on setting up networking with Windows 95, refer to the documentation
that came with your copy of Windows 95.
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CHAPTER 5

Using SunPCi Software

This chapter explains how to use the SunPCi window, command line, menus, and
dialog boxes. The chapter also provides instructions for working with SunPCi drives,
including diskette and CD-ROM drives. In addition, this chapter explains how to use
the Copy and Paste commands to copy and paste text between the X Windows on
your workstation and Windows 95, as well as how to set up printing on SunPCi.

The following list describes the topics covered in this chapter:

� “The SunPCi Command Line” on page 25 “The SunPCi Command Line” on page
25

� “The SunPCi Window” on page 27 “The SunPCi Window” on page 27

� “SunPCi Drives” on page 28 “SunPCi Drives” on page 28

� Using the Copy and Paste Commands “Using the Copy and Paste Commands”
on page 35

� “Printing from Windows 95 Using Solaris Printers” on page 36 “Printing from
Windows 95 Using Solaris Printers” on page 36

The SunPCi Command Line
To use a command-line option with the sunpci command, type the command,
followed by a dash, followed by the command-line option, followed by any required
file name or command (if needed).

For example:

% sunpci - option
filename
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option is the command-line option you want to use. filename is the name of the file
you want to use with the option. Not all options can accept file names. Note that
there is no space between the dash and the option.

For example, to start SunPCi software and route the Windows 95 screen to an
external VGA monitor, type the following:

% sunpci -vga

To start up SunPCi with a C: drive other than your default C: drive, type this
command and substitute the name of the new C: drive file for C.newdrive:

% sunpci -C C.newdrive

Table 5–1 lists the available SunPCi command-line options.

TABLE 5–1 SunPCi Command-Line Options

Option Purpose

-vga Routes the Windows 95 screen to an external VGA monitor. For more
information on how this option works, refer to “Connecting an External
Monitor to SunPCi” on page 18.

-C filename Boots the SunPCi window using filename as drive C: . This overrides the
default drive specified in the default properties file /$HOME/pc/
SunPCi.ini .

-D filename Boots the SunPCi window using filename as drive D: . This overrides the
default drive specified in the default properties file /$HOME/pc/
SunPC.ini .

-h SunPCi command-line help; displays a list of all SunPCi command-line
options.

-p filename Starts SunPCi with the configuration information in the properties file
specified with filename. The default properties file for SunPCi is $HOME/
pc/SunPC.ini .
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Exiting SunPCi
To exit SunPCi, you need to perform two steps:

� Exit Windows 95

� Exit the SunPCi window

Note - Always shut down Windows 95 from the Start menu before exiting the
SunPCi window. Otherwise, your files and applications could become corrupted.

The following steps explain how to shut down SunPCi properly.

1. In Windows 95, click on Start, and then choose Shut down the computer.

Windows 95 closes and displays the following message:
It is now safe to turn off your computer .

2. From the File menu in the SunPCi window, choose Exit.

The SunPCi Window
The first thing you see when you start SunPCi software is the SunPCi window. This
window provides the emulated DR-DOS command prompt, from which you run
your DOS programs. If you have installed Windows 95, you will see the DOS
prompt displayed for a few seconds before your Windows program starts in the
SunPCi window.

The following sections describe the menus at the top of the SunPCi window.

File Menu
The SunPCi File menu contains two commands: Reset PC and Exit.

Resetting a SunPCi window is the same as pressing Ctrl+Alt+Delete on a PC (also
called a warm boot). There are three primary reasons to reboot a SunPCi window:

� To enable changes made to your system as a result of installing certain software
packages, or modifying DOS files like AUTOEXEC.BATor CONFIG.SYS.

� To enable a different SunPCi emulated hard drive (see “Emulated Hard Drives” on
page 29 for more information about this).

� If either your keyboard or the application you are running in the SunPCi window
is no longer responding.
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The Exit command quits the SunPCi application and closes the SunPCi window.

When you choose the Reset PC command from SunPCi, a dialog box appears asking
if you want to reset SunPCi. Click OK to dismiss the dialog box, and SunPCi reboots.

Options Menu
The Options menu lets you create and choose emulated hard disk drives (C: and D:
drives). It also enables you to attach the mouse to SunPCi, which you will need to do
after you have installed Windows 95, but before you install the SunPCi drivers.

Table 5–2 describes the disk-related commands in the Options menu. Complete
instructions for choosing emulated drives is provided in “Creating and Configuring a
New C: or D: Drive” on page 12.

TABLE 5–2 Options Menu Disk-Related Commands

Setting Purpose

Attach a Hard
Drive

Specify the emulated hard drive (directory/file name) you want to assign
to drive C: or D:.

Create a New
Hard Drive

Create the file you want to use as an emulated drive.

Eject CD Ejects the CD from the CD-ROM drive. The keyboard shortcut is Meta-E.

Attach Mouse Works the same as Meta-M; allows you to attach the mouse to the
SunPCi window when you are in SMI mode. (This happens automatically
after you install the SunPCi drivers.)

SunPCi Drives
SunPCi software uses three different kinds of disk drives:

� Emulated hard drives (C: and D:)

� Extended (network) hard drives, including the CD-ROM drive

� Diskette drives (A:)
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Emulated Hard Drives
When you install the SunPCi software, it creates a default C: drive and assigns it to
an emulated drive file named C.diskimage , which resides in your ~/pc directory.
By default, all SunPCi windows are booted from this drive C: and use the
COMMAND.COM, AUTOEXEC.BAT, and CONFIG.SYS files located on this drive.

Note - You can create several C: and D: drive files, all with different applications and
configurations, and attach a drive as needed. Only one C: drive and one D: drive can
be active at any one time. They may not be the same file; that is, do not attach a file
as drive C: and then attach the same file as drive D:.

“Creating and Configuring a New C: or D: Drive” on page 12 contains information
on how to create and configure these drives.

Backing Up Your C: Drive
Once you have successfully installed Windows 95, you can make a copy of the disk
image of your C: drive. This allows you to keep a backup copy of the drive in case
you need to recover the contents of your drive at any time.

Note - We strongly recommend that once you have installed and configured SunPCi
and your Windows applications, that you make a backup copy of your C: drive.

Your C: drive is actually a large file stored on the hard disk of your workstation. You
use the SunPCi cphd (copy hard disk) command to make a copy of the file.

To back up your C: drive, follow these steps:

1. Locate the disk image of your C: drive.

It should be located in the directory called pc within your home directory on
your workstation. To view the contents of the directory, type the following
commands and press Enter after each:

% cd ~/pc
% ls

You should see a listing of files, including the name you assigned to your C: drive
during installation (for example, C.diskimage ).

2. Make a copy of the file.

Type the following command, substituting the name of your hard disk and the
name you want to assign to the copy. Press Return.

% /opt/SUNWspci/bin/cphd C.diskimage C.diskimage.copy
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Extended Drives
An extended drive is a directory that gives you access to the Solaris file system from
the SunPCi program. They can be accessed on your local system, or remotely across
the network. With extended drives you can share applications and data files. The
SunPCi program permits up to 22 extended drives for storing applications and files.

There are three different kinds of extended drives:

� redirected drives

� file system drives

� network drives

Redirected Drives
A redirected drive is a drive that is mapped for you in DOS. The default extended
drives F:, H:, and R: are redirected drives.These drives are automatically set up for
you during SunPCi installation, and are named in your AUTOEXEC.BATfile. This
means that you do not have to access drive F: manually in order to use the DOS
commands it contains.

By default, SunPCi assigns the following extended drives:

� F: /opt/SUNWspci

� H: $HOME(your home directory)

� R: / (the root filesystem)

Note - The default extended drives F:, H:, and R: support only the DOS-based short
file names (8.3 file names) and not the Windows 95 long file names. Do not use the
default drives to install Windows 95 software; instead, map a new extended drive
(or drives) and use them to install the software. To map an extended drive, refer to
“Accessing Solaris Files and CD-ROMs From Windows 95” on page 31.

If desired, you can use rem (remark) statements to remove the default drive
mappings for H: and R: from your C:\autoexec.bat file and use them to mount
other extended drives.

Caution - Do not remove or remap drive F:, or SunPCi will not run.

File System Drives
A file system drive is an extended drive that you map using Windows Explorer to
directories on your Solaris file system. Unlike the redirected drives, file system drives
can make full use of long file names in Windows 95.
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Network Drives
A network drive is also mapped through Windows Explorer, but it maps to locations
on your network. To access Solaris files and CD-ROMs from Windows 95, you will
need to map them as network drives as described in the following procedure.

Accessing Solaris Files and CD-ROMs From Windows 95
This section explains how to assign and use Solaris extended drives (network drives)
with SunPCi and Windows 95 using the Windows Explorer.

To map a Solaris drive or directory to work with Windows 95, perform the following
procedure:

1. Click Start and select Programs and Windows Explorer from the pop-up menus.

The Exploring screen is displayed.

2. From the Tools menu, select Map Network Drive .

The Map Network Drive dialog box is displayed.

3. Click on the drop-down arrow to the right of the Drive: field.

A list of unassigned drive letters is displayed on the drop-down menu.

Note - Any extended drive that is already mapped in the autoexec.bat file
(such as the default drives F:, H:, and R:) will appear on the list, but you cannot
use them for mapping. If you attempt to re-map these drives, the system will
return a Device not connected error.

4. Scroll downward until you find the drive letter you want, and then click to
select it.

The drive letter is displayed in the Drive: field.

5. Type the following path into the Path: field, substituting the names of your
directory and subdirectory:

\\directory\subdirectory , or
\\directory\.

For example, to map a Solaris CD-ROM to work with Windows, use this path:

\\cdrom\cdrom0
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Note - A mapped path requires two components, so if you want to map a drive
to a UNIX subdirectory component that has only one element, you will need to
use a period (.) as the second element. For example:

\\home\.

Note - Do not use an asterisk in the mapping path, or Windows 95 will return a
Device not connected error.

6. If you want this extended drive to map automatically whenever you start up
SunPCi, click the checkbox next to Reconnect at logon .

Click OK. The new extended drive appears in the Exploring window.

Mapping a Drive Letter to a Directory with a Long Path
If you need to map a drive to a UNIX directory that contains more than two path
elements (/directory/subdirectory/subdir2 ), you will need to use UNIX
symbolic links. For example:

1. Become root on your machine.

2. Create a link from your root filesystem, substituting your path for the one
shown in the following example. Type the following command and press
Return:

# ln -s /net/typicalmachine/files1/anydir /anydir

3. Click Start and select Programs and Windows Explorer from the pop-up menus.

The Exploring screen is displayed.

4. From the Tools menu, select Connect Network Drive .

The Map Network Drive dialog box is displayed.

5. Click on the drop-down arrow to the right of the Drive: field.

A list of unassigned drive letters is displayed on the drop-down menu.

6. Scroll downward until you find the drive letter you want, and then click to
select it.
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The drive letter is displayed in the Drive: field.

7. Type the following path into the Path: field, substituting the names of your
directory for anydir :

\\anydir\.

8. If you want this extended drive to map automatically whenever you start up
SunPCi, click the checkbox next to Reconnect at logon .

9. Click OK.

The new extended drive appears in the Exploring window.

Your network drive now maps to /anydir , which is a symbolic link to the
destination directory /net/typicalmachine/files1/anydir .

Installing Windows 95 Applications on Extended Drives
You can install Windows 95 applications on either of your emulated drives (C: and
D:), or on any of the drives that you create using Windows Explorer. Because of the
DOS file name limitations on the default extended drives (F:, H:, and R:), you should
avoid installing Windows 95 applications on the default extended drives. Refer to
“Extended Drives” on page 30 for more information on the default extended drives.

Diskette Drives
If the workstation you are using has an internal diskette drive, it is referred to in
Windows as drive A:.

Note - If you are running Volume manager (vold ) on your workstation, you will
need to disable Volume Manager’s control of the floppy drive before the floppy will
function under SunPCi. The script vold_floppy_disable , located in the
/opt/SUNWspci/bin directory, disables vold control of the floppy. To use the
script, run it before you start up SunPCi. Otherwise, you will not be able to use the
floppy drive as drive A:.

Most workstations come with one diskette drive; however, there are some
SPARCstation systems that do not have a built-in diskette drive. If you have a
SPARCstation system that does not have a built-in diskette drive, you will need to
have one installed if you intend to install software or copy data from diskette.
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Ejecting Diskettes
To eject the diskette from the drive, first use the following command in a UNIX
window:

% eject floppy

The system returns the following message:

/dev/rdiskette can now be manually ejected

Press the manual eject button on your workstation’s floppy drive to eject the diskette.

Using Low-Density Diskettes
Under the SunPCi program, just as on a PC, low-density diskettes must be
formatted, read, or written as low-density diskettes. To format low-density diskettes,
you must explicitly specify the diskette parameters while formatting.

To format a low-density DOS diskette, perform the following step:

1. At the DOS prompt, enter the DOS format command with /t and /n options.

For example, enter the following command at the DOS prompt:

C:\> format a: /t:80 /n:9

For more information about the format command, enter HELP FORMATat the
DOS prompt.

CD-ROM Drives
You can connect to CD-ROM drives from within the SunPCi program to access DOS
and Windows software. The CD-ROM must be in the High Sierra File System (HSFS)
format (which includes most, but not all, commercially sold CDs), and it can only be
accessed by creating a SunPCi extended drive. The SunPCi software does not
support Microsoft CD-ROM extensions.

This default drive mapping does not support long file names for use with Windows
95. To install software from a CD that requires long file names, map your CD-ROM
drive to another drive letter, such as Z:, using Windows Explorer. For instructions on
how to do this, refer to “Accessing Solaris Files and CD-ROMs From Windows 95”
on page 31.
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Note - If you have Solaris Volume Manager enabled, the default drive mapping for
your CD-ROM drive is R:\cdrom\cdrom0 .

To eject the CD from your CD-ROM drive, use the Eject CD command under the
Options menu or press Meta-E.

Using the Copy and Paste Commands
The SunPCi software allows you to copy text between UNIX windows on your
workstation and Windows 95. This section explains how to use your workstation
keyboard keys to copy and paste.

Note - Font information is not passed along in Copy and Paste operations. Special
characters and fonts may produce unexpected results when copied and pasted
between UNIX and Windows. For best results, use plain text.

Copying Text From a UNIX Window To Windows
95
To copy text from a UNIX Window and paste it into Windows 95, perform these steps:

1. Use the mouse to highlight the text you want to copy, and then press the Copy
key.

2. To paste the text into a Windows document, position the cursor where you
want the text to appear and use the standard Windows Paste command, Ctrl+V.

Copying Text From Windows 95 To a UNIX
Window
To copy text from Windows 95 and paste it into a UNIX Window, follow this
procedure:

1. Use the mouse to highlight the text you want to copy, and then use the
Standard Windows Copy command, Ctrl+C.

2. To paste the text into the UNIX window, position the cursor where you want
the text to appear, and then press the Paste key.
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Printing from Windows 95 Using Solaris
Printers
This section explains how to configure your Windows 95 settings on SunPCi so that
you can print using your workstation’s network printer.

Note - SunPCi does not support printing as a DOS printer. It is possible to select that
option during the setup process, but it will not function.

To set up the printer from Windows 95, follow this procedure:

1. From the Start menu, choose Settings, and then choose Printers.

The Printers window is displayed.

2. Double-click on the Add New Printer icon.

The Printer Wizard dialog box is displayed.

3. Click on Next. Select Network Printer, and then click the Browse button.

The Browse for Printer window is displayed.

4. Double-click on Entire Network to display all of the domains connected to
your network.

5. Locate SunPCi Host in the list of domains. Click on the plus sign (+) next to
the name “SunPCi Host” to show the list of workstations in the domain.

6. Locate the name of the system (print server) that corresponds to the printer you
want to use.

7. Double-click on that machine name to show the printer connected to the
machine.

Make sure you know the model of the printer you are using so that you can
select the correct printer driver. For most PostScript printers, the Apple
LaserWriter IINTX driver works best.

8. Click on the printer and then click OK, and then follow the instructions
described in the Printer Wizard dialog boxes.

You are now ready to use your workstation’s network printer as a Windows 95
printer. For more information on how to print from Windows 95 applications,
refer to the documentation that came with your copy of Windows.
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APPENDIX A

Troubleshooting

This appendix provides tips for rectifying problems you may encounter while using
SunPCi software. The following list describes the troubleshooting topics included in
this appendix.

Known Problems With SunPCi
This section describes some known problems with this release of SunPCi. Updates to
this information and workarounds (if available) will be posted to the SunPCi home
page at http://www.sun.com/ .

Running Microsoft Windows 95 Applications

Running Windows 95 From CD-ROM
Windows 95 cannot be installed with the “Run From CD-ROM” option. Use any of
the other options.

SunPCi Appears to Hang When Browsing Network Drives
If you are running Solaris 2.6 on your workstation, you may observe a very long
time lag when browsing network drives. SunPCi may even appear to hang as it
searches the contents of the drives. This is a feature of Solaris 2.6 and Solaris 7.
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Solaris 2.6 contains a “browsing” feature that allows you to automatically view all
automount points on your workstation. In Solaris 2.5.1 and earlier versions,
automounted directories are not visible until they have been mounted.

This may cause Windows 95 applications to slow down considerably when browsing
for files on your workstation (especially on your R: drive, which is / ), and may cause
problems when viewing very large directories with Windows Explorer or saving to a
subdirectory in one of these directories.

You can turn off this problem by editing the Solaris 2.6 auto_master file. To edit
this file, perform the following steps:

1. Use a text editor to open the file /etc/auto_master.

The file should look similar to the following:

# Master map for automounter # +auto_master /net -hosts -nosuid,nobrowse /
home auto_home -nobrowse /xfn -xfn

1. Move the +auto_master line in the file to the bottom of the list, after
-nobrowse . If the -nosuid, nobrowse and -nobrowse keywords are not
present in the file, add them.

The result should look similar to the following:

# Master map for automounter # /net -hosts -nosuid,nobrowse /home
auto_home -nobrowse/xfn -xfn +auto_master

1. Save the file and exit the text editor.

2. Reboot your system.

The “browsing” feature should be turned off.

Directory Operations From the DOS Window
The problems listed in this section refer to the DOS window that you access from
Windows 95. They do not refer to DOS windows running under OpenDOS 7.01.

Displaying Shortname Tails
When the DOS window reads a Windows 95-style long file name, it truncates the
long name into DOS format (that is, an eight-character file name followed by a
three-character extension) and adds a number to the file (such as ~1); this number is
called a shortname tail. When reading long file names on extended drives in the
Windows 95 DOS window, the window can only display shortname tails ending in
the number 1; it cannot display ~2, ~3, and so on.
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Reading Windows Formatted CDs
Some versions of Solaris (Solaris 2.5.1 and 2.6) are unable to read some Windows
formatted CDs, such as the RockRidge format. If SunPCi cannot read a CD you are
trying to use, check the contents of the CD as described in the following procedure.

1. Open a Command Tool window on the Solaris desktop.

Enter the following commands:

% cd /cdrom/cdrom0
% ls -lR

If the system responds with a message similar to the following, it is unable to
read the setup file from your CD:

./setup.exe: No such file or directory

total 170

-r-xr-xr-x 1 root sys 45 Aug 21 1996 autorun.inf*

dr-xr-xr-x 2 root sys 2048 Nov 26 11:46 doc/

-r-xr-xr-x 1 root sys 11171 Nov 25 10:01 readme.txt

dr-xr-xr-x 2 root sys 2048 Nov 26 11:46 setup/

If this happens, you will need to download and install a Solaris patch. Instructions
for installation are included with the patch. You can find the patches at
http://access1.sun.com .

� Download patch 104560 for Solaris 2.5.1.

� Download patch 105486 for Solaris 2.6.

The SunPCi Installation Guide contains instructions on how to install the patches,
which are also included on the SunPCi software CD.

Network Neighborhood
When you open the Network Neighborhood on the Windows 95 desktop, the
Network Neighborhood window does not show My Workstation. The workstation
and the SunPCi card share the same network interface, so they do not “see” each
other on the network. Both can communicate with the network, however.
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International Keyboard Support
DOS uses the file C:\dos\keyb.com as its keyboard driver. However, Windows 95
uses the file C:\windows\keyb.com . This results in the loss of support for
international keyboards when you use Windows 95.

The following procedure explains how to modify your autoexec.bat and
config.sys files to use the DOS keyboard driver for international support.

For more information on international support, refer to Appendix B.

To restore support for international keyboards, follow this procedure:

1. In the SunPCi window, click the Start button, and then select Programs and
then Accessories from the pop-up menus.

2. Select Notepad, and then open your C:\autoexec.bat file.

3. Add the following line to the file:

C:\dos\keyb.com

4. Save the file and close it.

5. Open your C:\config.sys file.

The following line may appear:

rem DEVICE=C:\DOS\SETVER.EXE

If it does appear, remove the rem (remark) statement and save the file.

If it does not appear, add the line DEVICE=C:\DOS\SETVER.EXE to the file and
then save it.

6. Exit Notepad.

7. Click the Start button and then select Shut Down from the pop-up menu.

The Shut Down Windows dialog box appears.

8. Select Restart the computer in MS-DOS mode and then click Yes to reboot
SunPCi.

When SunPCi has finished rebooting, the MS-DOS prompt appears in the SunPCi
window.

9. Enter the following commands at the DOS prompt:

C:\> CD DOS
C:\> SETVER keyb.com 7.01
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C:\> win

This sets the keyboard driver to the proper version and starts Windows 95.

You will need to enter the CD DOSand SETVERcommands every time you start
SunPCi. You may want to configure your SunPCi system to automatically boot to the
DOS prompt each time. Refer to Appendix C for instructions on how to configure
your system.

Troubleshooting SunPCi Hardware
Table A–1 contains some basic information on possible problems you might
encounter with the SunPCi card and how to fix them.

TABLE A–1 SunPCi Error Messages

Error Message Description

The SunPCi
drivers
could not be
loaded. Is
another
session
running?

This message may have appeared for one of the following reasons:
� You already have a SunPCi session running. Quit the other session

before running SunPCi again.
� You removed the SunPCi card and then reinstalled it in a different

PCI slot in your workstation. If possible, remove the card and install
it into the PCI slot it first occupied.

� You started up SunPCi without first restarting your workstation after
you installed the card. Log in as superuser, type in halt at the #
prompt to halt your system again, and restart at the ok prompt using
boot -r .

Driver
couldn’t be
loaded.
SunPCi
cannot open
the device.

Make sure that the board is securely seated in the PCI slot.

Your BIOS may
be out of
date.

You need to update your BIOS. Refer to the SunPCi Installation Guide for
information on how to flash the BIOS.
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Problems Installing the SunPCi Package
This section lists some possible problems with SunPCi installation.

Cannot Install SunPCi Software
When installing SunPCi software, you may receive one of the error messages in this
section.

Not enough disk space to install SunPCi.

Delete unnecessary files, applications, or both to make more disk space available.
If necessary, ask your system administrator for assistance. When you have created
or obtained more disk space, start the SunPCi installation again. Alternatively, you
can install SunPCi on a different disk or system.

You need additional swap space to install and run the SunPCi
software.

SunPCi software requires a minimum of 12 Mbytes of swap space. Increase the
amount of swap space on your system and then try installing SunPCi software
again.

Problems Installing Windows 95 or
Windows 95 Applications
Installing Applications
Whenever you install new applications on SunPCi, make sure you have your
Windows 95 CD available. The installation program may require files from the
Windows 95 CD.
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Mouse
Two Mouse Cursors Appear On Screen
If you see two mouse cursors on your SunPCi screen, then you may not yet have
installed the SunPCi drivers. To use the mouse before you install the drivers, choose
Attach Mouse from the Options menu, or press Meta-M. After you have finished
installing the drivers, the mouse will operate normally.

Mouse Movements Appear Jerky After SunPCi
Installation
If you notice that the mouse movements are jerky in SunPCi, you may not yet have
installed the SunPCi drivers. Refer to Chapter 3 for information on how to install the
drivers. After you have finished installing, you will notice that the mouse movement
appears much more smooth.

Diskette Drives
Cannot Access Diskette in Diskette Drive
SunPCi software and the Solaris Volume Manager program (vold ) tend to conflict
with each other for control of the diskette drive. Volume Manager provides
automatic mounting services for peripheral devices attached to your system, such as
diskette drives.

The conflict arises when Volume Manager support is enabled on your system and
you attempt to access a diskette drive through a SunPCi window. In such instances,
an error message is displayed and the diskette access fails.

By default, when SunPCi software is installed, Volume Manager support is disabled
for diskette drives, and so most users will not encounter a problem. However, it is
possible to re-enable Volume Manager on your system, and thus encounter the
problem at a later time.

If Volume Manager support for diskette drives has been re-enabled on your system,
and you encounter problems accessing diskette drives through SunPCi, try disabling
Volume Manager and restarting the SunPCi window. If the problem persists, try
disabling Volume Manager and rebooting your system.
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To disable the Solaris Volume Manager, perform
the following steps:

1. Make sure that SunPCi is not running. Become superuser.

2. Disable Volume Manager by entering the following command:

# /opt/SUNWspci/bin/vold_floppy_disable

3. Exit superuser.

4. Restart all SunPCi windows.

Cannot Eject a Diskette From a Solaris Command
Window
If the message eject: open failed on /dev/rdiskette.Device busy is
displayed, then another Solaris command window may have control of the diskette
drive. Refer to “Ejecting Diskettes” on page 34 for more information.

Cannot Use Low-Density Diskettes
The diskette is probably not formatted correctly. Refer to “Using Low-Density
Diskettes” on page 34 for more information.

Emulated Hard Drives
Attaching Drive C:
To be sure that you will always be able to attach drive C:, you can change the
permissions on the drive. Changing the permissions will keep other users from being
able to attach drive C: even when you are not using the SunPCi program. To change
permissions on drive C:, type the following in a command window:

% chmod 600 ~/pc/C.diskimage

This makes the drive inaccessible to other users.
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Disk Error Messages
If your SunPCi window shows the message Non-system disk or disk error at
startup, your C: drive may have been corrupted, or you have a non-bootable floppy
disk in drive A:. If you do not have a floppy disk in drive A:, delete the default C:
drive file in $HOME/pc and then restart SunPCi.

You may want to make periodic backup copies of your C: drive. Refer to “Backing
Up Your C: Drive” on page 29 for more information.

CD-ROM Drives
Cannot Map a Solaris CD-ROM Drive in Windows
Explorer
If you are trying to access Solaris files and CD-ROMs drives from Windows 95 and
you are unable to use the Map Network Drive command in Windows Explorer to set
up the drive, be sure to check the following:

� Make sure you have the CD in the CD-ROM drive. This is the most likely reason
that a drive mapping may not work.

� Make sure you entered the path for the CD-ROM drive as \\cdrom\cdrom0 ,
with two backslashes at the beginning.

Extended Drives
Cannot Mount Extended Drives With Windows
Explorer
If you cannot mount extended drives, networking may not be installed on
SunPCi.Try to log in to the network first. If you can reach the network from the
UNIX side, then go to the Start menu in SunPCi and select Control Panel, then
double-click on Network. Set up your SunPCi installation on the network. Refer to
your Windows documentation for more information.If you still cannot connect to the
network after logging in, you will need to reinstall Windows 95.

To log in to the network, start up SunPCi and enter your user name and password
when the dialog box prompts you to log in to Microsoft Networking.

To log in to the network if you are already running SunPCi, follow this procedure:
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1. Click the Start button and then select Exit.

2. When the dialog box asks you whether you want to shut down or restart the
computer, click on Restart.

3. When the Microsoft Networking dialog box appears, type in your user name
and password and press Return.

You will then be able to mount extended drives. Refer to “Extended Drives” on page
30 for instructions on how to use Windows Explorer to map network drives.

Keyboard
Backspace Key Does Not Work in DOS
Do not map the Delete key to the Backspace key. If you do this, you will not have a
Backspace key available when you are working with DOS applications. When you
press the Backspace key, it will not backspace, but will instead delete the character at
the current cursor location. If you have mapped these two keys by modifying your
.xinitrc file, there will be a line in the file that reads:
xmodmap -e keycode 50 = delete . You should remove this line to restore the
original key assignments.

Networking
Cannot Connect to Other Systems
Before you start to diagnose problems using SunPCi to connect to other systems on
the network, make sure that you have configured SunPCi and your workstation as
follows:

� Your workstation and SunPCi host must have different IP addresses.

� Both the SunPCi host and the workstation should be located on the same physical
subnet, although they may be on different virtual subnets.

� Your workstation and SunPCi must have the same netmask. The value of the
netmask depends on the type of network you are using; contact your network
administrator for more information.
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If you are having trouble using SunPCi with TCP/IP, perform the following steps to
determine the cause of the problem.

Note - You will need to know the names and IP addresses of another system on the
same subnet as your workstation, and of a system not on the same subnet. Contact
your network manager if you do not have this information.

Diagnosing TCP/IP problems
1. In the SunPCi window, open a DOS window. In Windows 95, choose the Start

button and then select Applications and MS-DOS Prompt from the pop-up
menus.

The DOS Prompt window is displayed.

2. Enter the ping command, followed by the IP address of a system on your
subnet (not your workstation). For example:

C:\> ping 206.4.151.254

If this ping command succeeds, proceed to Step 1 on page 38. If it returns an
error such as Host not found , your SunPCi card may be using the wrong
subnet, or your netmask may be incorrect. Contact your network manager to
make sure you have the correct information.

3. Enter the ping command, followed by the name of the system you pinged in
Step 1 on page 38. For example:

C:\> ping bobswk

If this ping command succeeds, proceed to Step 1 on page 38. If it returns an
error, your DNS (Domain Name Service) needs to be reconfigured. Contact your
network manager for the host name, domain name, and IP address of each DNS
server on your network.

4. Enter the ping command, followed by the IP address of a system not on your
subnet. For example:

C:\> ping 199.172.10.2

If this ping command succeeds, proceed to Step 1 on page 38. If it does not
succeed, make sure that you have specified the correct network router. Contact
your network manager.
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5. Enter the ping command, followed by the name of a system not on your
subnet. For example:

C:\> ping maryswk

If this ping command succeeds, then TCP/IP is set up correctly. If it returns an
error, contact your network manager and double-check the information you set
up for the DNS servers as described in Step 1 on page 38.

Printers
This section describes some problems you may encounter when printing from
applications running under SunPCi software.

Problems Printing to a PostScript Printer
If you are having problems printing from an application to a PostScript printer, try
the following:

� Print to a file and print the file from a command window using lp filename. If this
does not work, it may be an indication that your printer is not configured
correctly. Make sure your default printer and any other printer you are trying to
access is set up in your /etc/lp/printers directory.

� Make sure the setting in your application matches the setting for the default
printer in your Windows 95 Network Control Panel. The Setup Wizard will have
already installed and configured the PostScript printer for you, if you performed
these steps during installation.

� Print to a file. View the file from a Solaris command window using od -a . If you
see the letters eot anywhere in the file, it is an indication that there are ^D
characters present in the file. The PostScript printer will not recognize these
characters.
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Starting SunPCi Software
Error Messages Encountered When Starting
SunPCi
When starting SunPCi software, you may encounter one of the following error
messages.

Command not found

Make sure that the SunPCi program directory—by default,
/opt/SUNWspci/bin —is in your environment PATH. Refer to Chapter 3 for
instructions.

Correct Solaris Installation Required
If you do not have the correct Solaris installation on your system, you will encounter
problems when attempting to start SunPCi software. SunPCi software requires at
least the End User System, Developer System, or Entire Distribution installations of
Solaris versions 2.5.1 and 2.6 and Solaris 7. SunPCi will not run if you only have the
Core System installed. Ask your system administrator for assistance in determining
which system is installed on your workstation.
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APPENDIX B

SunPCi International Support

SunPCi and DOS software give you the national language support you need to run
your applications on an international keyboard. The first time you started the SunPCi
program, as described in Chapter 3, you were presented with a list of regional
languages and countries from which to choose. You entered the number that
corresponded to the language or country your keyboard supports. These regional
languages and country names represent code pages in PC terminology. If you want
to change your code pages, use the instructions in this appendix.

This appendix discusses the following topics:

� “Using an International Keyboard” on page 51 “Using an International
Keyboard” on page 51

� “DOS Character Set” on page 52 “DOS Character Set” on page 52

� “Code Pages and SunPCi Software” on page 53 “Code Pages and SunPCi
Software” on page 53

Using an International Keyboard
Your Sun international keyboard fully emulates the local-language DOS AT/102
keyboard. Each keyboard offers all the characters in the US-ASCII and the local AT/
102 character set, plus any other characters routinely used within that country.

In general, there is nothing unusual about the way this keyboard works for most
characters. You press the key and the character appears on the screen. To get an
uppercase character, you either hold the Shift key or set the Caps Lock. If there are
three characters shown on the key, you hold the Alt-Graph key while pressing the
key to get the third character. However, there are a few special ways in which the
keyboard operates under DOS:
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� The keyboard provides access to more characters than are available on the
local-language DOS keyboard.

� Under both DOS and Solaris operating systems, some characters are used both as
accents and as separate characters, such as the carat (^) and the tilde (~). Under
the Solaris system, these characters have separate keys—one for use as a floating
accent and one for the separate character. Under DOS, there is one key that
provides both functions. To use the key to enter a floating accent, press the key. To
use the key to enter a separate character, simultaneously press the key and the
space bar.

� Characters that are not available on the local DOS keyboard may be ignored when
you attempt to use them.

Windows 95 Support for International Keyboards
Windows 95 uses a different keyboard driver than does DOS. To support
international keyboards under Windows 95, you will need to load the DOS keyboard
driver. “International Keyboard Support” on page 40 explains how to perform this
procedure.

DOS Character Set
Whenever you, or a program you are using, creates a file under DOS, the DOS
character set is used. Whenever you create a file under the Solaris system, the ISO
8859 Latin 1 character set is used. You do not need to be aware of this unless you
want to use a DOS file in the Solaris environment, or a Solaris file in the DOS
environment. To convert files from one format to the other, two conversion utilities
are provided—dos2unix and unix2dos . Only characters that are available in both
the DOS character set and the ISO 8859 Latin 1 character set can be converted
between formats. Fortunately, most commonly used characters are available in both
character sets.

However, if you have a text file that contains special characters, these characters may
not be convertible. Most word processors and text-processing programs use special
codes in their files to indicate character style or page layout. Most of these programs,
however, have options to store the file as “text only” or to “print to a file,” which
eliminates the special codes and allows you to convert the file using the dos2unix
and unix2dos commands.
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Code Pages and SunPCi Software
DOS provides national language support through the use of language-specific code
pages. The first time you start the SunPCi program, code pages are set for you when
you are presented with a screen that instructs you to enter the number of the country
matching your keyboard.

If you want to change code pages at some time, follow the instructions in the section
“Using Code Pages” on page 55.

What Is a Code Page?
A code page is a table that defines the character set you are using. Each character set
contains 256 entries specific to a country or language. The characters are translated
from the code page table and used by your keyboard, screen, and printer. An
example is the set of letters, numbers, and symbols (such as accent marks) used by
French-Canadians. When the character set is put into a table for use by DOS, it
becomes the Canadian-French code page.

There are two types of code pages, hardware and prepared. A hardware code page is
built into a device. For example, a printer manufactured for use in Portugal has a
Portuguese hardware code page in it. Many devices can use only their own
hardware code page.

Prepared code pages are provided in code-page information (.CPI ) files in your
software. OpenDOS includes the following prepared code pages:

� 437 – United States code page

� 850 – Multilingual code page, including all characters for most languages of
European, North American, and South American countries

� 860 – Portuguese code page

� 863 – Canadian-French code page

� 865 – Nordic code page, including all characters for the Norwegian and Danish
languages

Devices Supporting Multiple Languages
The following devices can use prepared code pages to switch from one language to
another:

� EGA and VGA displays or compatible

� IBM Proprinter model 4201 or compatible
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� IBM Proprinter model 4208 or compatible

� IBM Quietwriter III printer model 5202 or compatible

� Epson FX850 and FX1050 printers

� Printers compatible with the above printers

For example, you have EGA support with the SunPCi program that allows you to
switch between the United States code page and the Multilingual code page by
entering the appropriate DOS commands. With prepared code pages, a single system
can support multiple national languages.

National Language Support Codes
When you use commands to set up your system for a national language, DOS makes
sure the screen, printer, and keyboard codes you request work together. The valid
combinations of prepared code pages, country codes, and keyboard codes are
defined in the COUNTRY.SYSand KEYBOARD.SYSfiles. The supported combinations
are listed in Table B–1.

Both Swiss-French and Swiss-German use country code 041. Country codes 358 and
972 assume United States code page 437, but include country-specific date and time
conventions. For example, if you use country code 351 (Portugal), you can use
prepared code pages 860 and 850 and the po (Portugal) keyboard code. You could
not use the us (United States) keyboard code. If you enter a country code 002 with a
us keyboard code, DOS displays an error message when you restart the system.

TABLE B–1 National Language Support

Country, Region, or Language Country Code
Prepared Code
Pages Key Code

United States 001 437, 850 us

Canadian-French 002 863, 850 cf

Latin America 003 437, 850 la

Netherlands 031 437, 850 nl

Belgium 032 437, 850 be

France 033 437, 850 fr

Spain 034 437, 850 sp

Italy 039 437, 850 it
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TABLE B–1 National Language Support (continued)

Country, Region, or Language Country Code
Prepared Code
Pages Key Code

Switzerland 041 437, 850 sf, sg

United Kingdom 044 437, 850 uk

Denmark 045 865, 850 dk

Sweden 046 437, 850 sv

Norway 047 865, 850 no

Germany 049 437, 850 gr

English (International) 061 437, 850 -

Portugal 351 860, 850 po

Finland 358 437, 850 su

Israel 972 437 -

Japan 081 ja

Korea 082 ko

Peoples Republic of China 086 ch

Taiwan 088 tn

Using Code Pages
The following sections explain the basics of using code pages, including how to set
up your system to support a particular character set. Also, several examples, using
different hardware and prepared code pages, are provided. The examples show you
how to set up your system to support national languages. It is assumed that all DOS
files are in the directory \dos on drive C:.
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Setting the System Code Page
DOS uses the AUTOEXEC.BATand CONFIG.SYS files to set up system code pages to
support a national language. Examples of CONFIG.SYS commands are shown later
in this chapter. Remember, when you change your CONFIG.SYS file, you must
reboot the SunPCi window to enable the new settings.

To set up your system to support a character set, follow these procedures.

Edit your CONFIG.SYS file by performing the following steps:

1. Use the country configuration command to control country-specific
characteristics such as the time format, date format, currency symbol, and
character-sorting sequence.

2. Use a device configuration command to tell DOS the hardware code page is a
device and to allocate buffers for prepared code pages.

3. Use an nlsfunc command to load the memory-resident national support
functions. If you forget to issue the nlsfunc command, DOS will not allow
you to specify code pages or keyboard codes.

In your AUTOEXEC.BATfile, use the following commands:

1. Use a mode cp prepare command to prepare code pages for each device that
supports code-page switching.

2. Use a keyb command to select the keyboard layout.

3. Use a chcp command to select the code pages for all prepared devices. DOS
automatically prepares two system code pages and selects the primary code
page for your country. If you want to use the other code page prepared for your
country, you can use the chcp command again.

After you have finished setting the system code page by editing your CONFIG.SYS
and AUTOEXEC.BAT files, you can proceed to setting your country and keyboard
codes

Setting Country and Keyboard Codes
The first example uses only a hardware code page; code-page switching is not used.
The commands tell DOS to accept the country information for France and load the
French keyboard program. This example is similar in most European countries.

To the end of your CONFIG.SYS file, add the following line:

country=033,,c:\dos\country.sys
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To the AUTOEXEC.BATfile, add the following line:

keyb fr,,c:\dos\keyboard.sys

Note - The default AUTOEXEC.BATfile contains two lines at the end of the file that
invoke AUTOEXEC.BATfiles on the E: or H: drive. If your AUTOEXEC.BATfile still
contains these lines, place the international command lines before them.

Using Hardware and Prepared Code Pages
The next example uses two code pages—one hardware and one prepared. In this
instance, the system you are setting up uses the German code page provided in the
EGA and the United States code page provided by DOS.

To the end of your CONFIG.SYS file, add the following on separate lines:

country=049,,c:\dos\country.sys
device=c:\dos\display.sys con:=(ega,437,1)
install=c:\dos\nlsfunc.exe c:\dos\country.sys

These CONFIG.SYS statements tell DOS that the hardware code page (437) in the
Enhanced Graphics Adapter should be used, and that you are allocating space for one
prepared code page. Also, they load memory-resident, national support functions.

To the end of your AUTOEXEC.BATfile, add the following exactly as shown (on
separate lines):

mode con cp prep=((437)c:\dos\ega.cpi)
keyb gr,,c:\dos\keyboard.sys
chcp 437

These AUTOEXEC.BATcommands do the following:

� Load prepared code page 850 into memory—they get the code page from the
EGA.CPI file.

� Load the German (gr) keyboard program.

� Start the system with the United States (437) code page.
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Setting Device Code Pages
The following two sections describe two methods for setting a code page for a
specific device, including a console screen and a printer.

Setting Screen Code Pages
This example uses two prepared code pages—no hardware code pages are used—to
set up the system to support Denmark/Norway and the Multilingual national
languages.

To the end of your CONFIG.SYS file, add the following on separate lines:

country=045,,c:\dos\country.sys
device=c:\dos\display.sys con:=(ega,,2)
install=c:\dos\nlsfunc.exe c:\dos\country.sys

These CONFIG.SYS commands tell DOS that the EGA’s hardware code page is not
used, and that you are allocating space for two prepared code pages. Also, they load
memory-resident, national support functions.

To the AUTOEXEC.BATfile, add the following exactly as shown (on separate lines):

mode con cp prep=((865,850) c:\dos\ega.cpi)
keyb dk,,c:\dos\keyboard.sys
chcp 865

Note - If the AUTOEXEC.BATfile contains two lines at the end of the file that invoke
AUTOEXEC.BATfiles on the E: or H: drive, place the international command lines
before these lines.

These AUTOEXEC.BATcommands do the following:

� They load prepared code pages 865 and 850 into memory—they get the code
pages from the EGA.CPI file.

� They load the Denmark (dk) keyboard program.

� They start the system with the Denmark/Norway (865) code page.

Note - Refer to your DOS manual for information on the PRINTER.SYS file and the
types of printers it supports for code-page switching.
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Setting Parallel Printer Code Pages
The second example also uses two prepared code pages. It assumes you have an IBM
Proprinter model 4201 connected to LPT1. The system is set up to support Denmark/
Norway and the Multilingual national languages.

To the end of your CONFIG.SYS file, add the following on separate lines:

country=045,,c:\dos\country.sys
device=c:\dos\display.sys con:=ega,,2
device=c:\dos\printer.sys lpt1:=4201,,2
install=c:\dos\nlsfunc.exe c:\dos\country.sys

These CONFIG.SYS commands tell OpenDOS that the hardware code page is not
used, and that you are allocating space for two prepared code pages in each device.
Also, they load memory-resident, national support functions.

To the AUTOEXEC.BATfile, add the following on separate lines:

mode con cp prep=((865,850)c:\dos\ega.cpi)
mode lpt1 cp prep=((865,850)c:\dos\4201.cpi)
keyb dk,,c:\dos\keyboard.sys
chcp 865

Note - If the AUTOEXEC.BATfile contains two lines at the end of the file that invoke
AUTOEXEC.BATfiles on the E: or H: drive, place the international command lines
before these lines.

These AUTOEXEC.BATcommands do the following:

� They load prepared code pages 865 and 850 into memory. For the EGA, they get
the code pages from the EGA.CPI file. For the printer, they get the code pages
from the 4201.CPI file.

� They load the Denmark (dk) keyboard program.

� They start both devices with the Denmark/Norway (865) code page.

Switching Between Code Pages
After using the CONFIG.SYS and AUTOEXEC.BATfile commands to set up your
system for multiple national languages, use the following command to change to a
different code page on all devices or for a single prepared device:

C:\> chcp code page

SunPCi International Support 59



or

C:\> mode device cp select= code page

where:

code page is one of the pages set up in AUTOEXEC.BATand device is CONor LPT1.

Listing Current Code Pages
You can list the current prepared and selected code pages for your console screen or
a parallel printer by using the mode command in the following form:

C:\> mode device cp

Displaying Current Device Code Pages
To display the current code pages for your console screen device, enter the following:

C:\> mode con cp

OpenDOS displays a message similar to this one:

Active code page for device CON is 437 hardware code pages: Code page 850 prepared c o

Refreshing Lost Code Pages
It is possible for prepared code pages to be lost due to hardware errors. For example,
suppose you had selected the Canadian-French code page (863) as the active code
page for your console screen (CON). But, because of a hardware error, the active code
page was lost. You can use the refresh keyword with the mode command to
restore the lost code page for your screen, by entering the following:

C:\> mode con cp refresh
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The $LANG Variable
There are two Solaris commands—dos2unix and unix2dos —that enable you to
specify code pages. For example, to convert the task_list file, created with code
page 850, from a DOS to a Solaris format, use the dos2unix command, and enter
the following:

C:\> dos2unix -850 task_list task_list

If the code page is not specified on the command line, dos2unix and unix2dos
will check the $LANGenvironment variable to determine which code page to use. To
check whether your $LANGvariable is set, enter the following in a Solaris command
window:

% env | grep LANG

If you do not have the $LANGvariable set, or if it is set to anything but the settings
listed in the following table, SunPCi software uses the default US code page 437 and
the en_US (English-US) $LANGsetting.

TABLE B–2 $LANGVariable Settings

$LANGVariable Setting Language/Territory

c Default “C” locale

ar Arabic

bg Bulgarian

ca Catalan

co Corsican

cs Czech

cy Welsh

da Danish

de German

de_CH Swiss German

el Greek
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TABLE B–2 $LANGVariable Settings (continued)

$LANGVariable Setting Language/Territory

en English

en_UK UK English

en_US US English

eo Esperanto

es Spanish

eu Basque

fa Persian

fi Finnish

fr French

fr_BE Belgian French

fr_CA Canadian French

fr_CH Swiss French

fy Frisian

ga Irish

gd Scots Gaelic

hu Hungarian

is Icelandic

it Italian

iw Hebrew

ja Japanese

ji Yiddish

kl Greenlandic

ko Korean
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TABLE B–2 $LANGVariable Settings (continued)

$LANGVariable Setting Language/Territory

lv Latvian

nl Dutch

no Norwegian

pl Polish

pt Portuguese

ro Romanian

ru Russian

sh Serbo-Croatian

sk Slovak

sr Serbian

sv Swedish

tr Turkish

zh Chinese

zh_TW Chinese Taiwan
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APPENDIX C

SunPCi Performance Tips

This appendix suggests various ways to improve the performance of the SunPCi
program and the performance of your Windows 95 applications. The following list
describes the topics in this appendix.

� “Fine-Tuning Your SunPCi Configuration” on page 65 “Fine-Tuning Your SunPCi
Configuration” on page 65

� “Windows 95 Specific Tips” on page 66 “Windows 95 Specific Tips” on page 66

� “Running Game Software on SunPCi” on page 68 “Running Game Software on
SunPCi” on page 68

Fine-Tuning Your SunPCi Configuration
The following sections describe some aspects of SunPCi configuration that you can
change to improve performance of the SunPCi software.

Memory
The more system memory you have, the better the performance of the SunPCi
program. A minimum of 64 Mbytes on the SunPCi card is suggested for running
SunPCi software; a 64-Mbyte memory module comes installed on the SunPCi card by
default. Windows software runs best with at least 48 Mbytes of RAM.

If you want to increase the amount of RAM allocated to SunPCi, you may want to
purchase the optional 128 Mbyte memory module. You can purchase two of them
and replace the 64 Mbytes memory module, for a total of 256 Mbytes. Refer to the
SunPCi Installation Guide for more information, or contact your Sun reseller.
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Emulated versus Extended Drives
You should specify as large a drive size as possible when creating a new C: or D:
drive. (Depending on the available space on your hard disk, you can specify up to
500 Mbytes.) Remember that the actual file size of your emulated drives varies,
depending on the applications and data you store on them.

For more information about using emulated hard disk drives, see the section
“Emulated Hard Drives” on page 29. For information about using extended drives,
see “Extended Drives” on page 30.

Windows 95 Specific Tips
This section contains hints and tips that you may find helpful if you are running
Windows 95.

Configuring Boot Options
This section contains two tips for configuring your boot options:

� Choosing your boot options from the Microsoft Windows 95 Startup menu

� Automatically booting to the DOS prompt

The Microsoft Windows 95 Startup menu contains options that you can choose when
you start SunPCi. You can choose to boot directly into DOS or start Windows in Safe
Mode.

Choices you make in the Startup menu affect only the current session of SunPCi. The
next time you reboot, the startup mode returns to the default (start Windows 95
automatically).

Accessing the Startup Menu
1. Start SunPCi and press F8 as soon as you see the

Starting Windows 95 message.

The Microsoft Windows 95 Startup Menu appears.

1. Enter the number that corresponds to the option you want to use. SunPCi will
start in the mode you selected.

Table C–1 explains the options available in the Startup menu.
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TABLE C–1 Startup Menu Options

Option Description

1 Normal Windows 95 startup.

2 Normal startup. The file BOOTLOG.TXTcontains a log of the results of
the startup process, including any system messages or errors.

3 Safe Mode starts your computer with default settings (VGA monitor,
no network, Microsoft mouse driver, and the minimum device drivers
required to start Windows).

4 Starts the computer in Safe Mode, but allows the computer to connect
to the network.

5 Requests a Yes or No confirmation for each step in the startup process.
The system displays each line in the CONFIG.SYS and
AUTOEXEC.BATfiles and asks you to confirm each one. Press Enter for
Yes or Esc for No.

6 Boots the system to the MS-DOS prompt.

7 Boots the system to the MS-DOS prompt in Safe Mode.

8 Boots the system to a previous version of MS-DOS (if you have one
installed).

Automatically Booting to the DOS Prompt
You can create an empty batch file called WIN.BAT that enables you to boot directly
into the DOS prompt every time you start SunPCi. This allows you to start Windows
95 whenever you choose, but allows you to work from the DOS prompt rather than
from the DOS shell.

1. To start Windows 95 from the DOS prompt, type the following command and
press Return:

C:\> windows\win
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Running Game Software on SunPCi
Note - This procedure applies only if you are using an external VGA monitor with
your SunPCi card. For more information on how to install and configure an external
VGA monitor, refer to Chapter 4.

This section is designed to help you fine-tune game performance on SunPCi.
Although the default VGA memory setting of 1 Mbyte on your SunPCi card should
provide enough VGA memory for most games, you may want to increase the
amount of VGA memory for more graphics-intensive games.

Note - Remember that increasing your video memory decreases the amount of
available system memory.

To increase the amount of VGA memory available to SunPCi, perform the following
procedure:

1. Start up SunPCi. If SunPCi is already running, exit Windows 95 and then
choose Reset PC from the File menu.

You will see the startup screen and the RAM check routine.

2. While the RAM check routine is proceeding, press the Del (Delete) key on
your keyboard.

The startup routine is stopped and the Setup screen is displayed.

3. Select Chipset Features Setup.

4. Change the VGA Shared Memory Size parameter to a larger value.

The default is 1 Mbyte. This parameter accepts values between 0.5 Mbytes and 4
Mbytes in increments of .5 Mbytes.

5. Exit Setup.

The SunPCi startup routine starts over, using your new VGA memory settings.
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